Statistics Summary Table

For more information on the Qutlier Test, see Outlier Test,
p. 147.

Chapter Eight

Method Validation

1. Method Validation Overview

The Method Validation software tests the variance and
the linearity of the data. It also determines performance
characteristics according to the requirements of DIN
38402-Part 51.

For method validation according to DIN regulations,
follow these steps:

1.
2.

Select the estimated working range.

Prepare 10 calibration standards, with concentrations
distributed uniformly over the complete working range.

Create a sample table, with 10 injections of the
highest and lowest standard concentrations and a
single injection for all other standards. If more than
one injection is made of the intermediate standards,
the linearity test is calculated with the results of the
first replicates only.

Analyze these standards. The results are saved in
a .calfile.

Select Method Validation from the TOC Control
Validation menu, or select DIN 38402 from the
Tocentr program folder. The Method Validation screen
appears.

From the Options menu, ensure that Validation
Strictly Following DINis enabled. If not, select the
menu item.

Select Open from the File menu.
Select .ca/ from the file type drop-down list.

From the File Name list, select the .ca/file where the
measurement data was saved. Then select OK.

10.The calculations are automatically performed, and the

validation data displayed.
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2. File Menu

S{;}m Smplp 4 [apm) ¥ia
1 ke 10.000 4280
2 2K 20,000 8306
FET) 30.000 12667
4 |4 Knp 40,000 16993
5 |5 KHP 50.000 20853
6 [6:KHP 50.000 25914
7 [mwepe 70,000 20725
8 g o £6.000 37448
3 o KNP 150,000 35045
$0 {0 KHP 1100.000 44569

The validation data is displayed

11.Select Save from the File menu, assign a file name in
the Save As dialog box, and select OK. The validation

data is saved with a .val file name extension. Open
~ Note: When the actual calibration finction doesn’t meet the
DIN specification, check the instrument for system errors,
or reduce the working range, then repeat the Validation. D dowe
For details, refer to the TOC 5000 / TOC 5050 instruction X come
manual, shipped with the instrument.
] Tt
Validation(" val) &3 volume 1
The Open dialog box
Select the directory where the desired file is located.
Select the type of file desired from the drop-down list. The
available file types are listed below (identified by file
name extension):
val
.val files are created by the DIN38402 program.
They contain results of validation calculations
performed on data.
.cal

.cal data files are created by the TOC Control
program. When these files are opened by the
DIN38402 program, validation calculations are
performed automatically.

Select the desired file from the list of file names that
appears.

Click OK.
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Save
Choose Save to save the displayed data in a previously-
named file. If the file has not been saved previously, the
Save As dialog box opens.
Save As
Choose Save As to save the current data under a new file
name or location. File type is determined automatically.
Print
Select Print to print the displayed data according to the
Print Options dialog box specifications (in the Options
menu).
Printer Setup
Select Printer Setup to display the Printer Setup dialog |
box. Options vary according to the system printer.
Close

Choose Close to exit the DIN38402 program.

Validation Menu

Complete

Several charts and tables are available for viewing in the
Validation program. Select desired items from this menu.

alidation

The Validation menu

All the information represented by the five menu items
below this command is displayed.

Datasheet

Measurement results of all samples and their replicates
are displayed in the table. When Validation Strictly
Following DIN is enabled (Options menu), only the first
replicate of each sample is used for computing the
linearity test and calibration function. In that case, the
unused replicates are displayed over a light blue
background color.

Complote Datashest:iinss

s;_;pl SnED i lpem} Vit vi2 i3 i4 Yis vig
1100 ppm 100.900 4336 4232 4205 4205 4222 4236
2 200 ppm 200.000 8430 Bas52 8380 B285. o . 84 .| 837
3 [300ppm 300,000 11710 11747 17 1716 - 11720 11857
4 | 400ppm 400.000 18608 16568 16689 - 16665 16778 16461
5 1500 ppm 500,000 23588 3832 23859 23742 23735 23689
& |600ppm 600.000 23785 - 23603 23582 2713 - | 23896 - - | 23473
7 |700ppm 700.00G 7887 ez 7E5 - - 27803 - 27641 216
8 |800ppm [609.006 323 3230 52 W7 s || HA¥S
9 |900ppm 900,000 35122 ;25 35292 . 35273 35425 35251
18 ;1000.60 ppm 1000.000 39760 395658 39880 39623 39619 3451

Linearity

Calculated results of the linearity test are displayed in
this spreadsheet.

On the left are the results of the linear regression
calculation; on the right, the corresponding results of the
quadratic calibration are displayed. The footer displays
the comparison between these two calculation methods.

158

159



Method Validation

TOC Control Software Manual

2580 Residusis
Linear Regression Regression 2nd order t ' T ' T 243
Slope(b); 350.76970 Regression coeft. (a): -279.51667 E .
Intercept(ay. ~321 93333 Regression coeff. (b): 348.54835 2 - i §
Regression coeft. (c); 0.01928 < or p ¥ . * s ¥ " " * 0090 E
Residusal SD: (Sy1 X MT33117 Residugl SO: (Sy2); 124.30957 8
Process SD; ($x1) 0.33450 Process SD: ($x2): 0.35439 ) T
Rel. Precess CV: (vl y 0.61% Ret. Process C: (vx2) 0.64% -35920 s . : L L \92.943
Coeff. of Correlgtion(r2): G.39%8492 Senstivity ECx 350.768870 Smpl No. "
Lower limit of determinatian (XpX 1.50182 The Residual Analysis dalasheet
Difference betwy, varigliens{DSA2): 196273485
Test value(Pyy): 012701
Value from F-table: 12.25000 f . '
Calibration Function
T —— - T — This graph displays the linear regression of the
ey S EAR V»ﬁ'ﬁ"{’ S e ) :
e G e calibration curve, as well as the levels of confidence ab ove
and below the calibration curve. This graph can he

The difference beween variance DS~2 and Sy242 is ot significant

customized; see p. 142 for more information.
The calibration function may be regarded as finesr in the warking range

The Linearity data sheet . ‘ Callration funclion ' _
Homogeneity of Variance ]
The replicates used, and the results of the homogeneity of
variance test, are displayed in this spreadsheet.
P " o g
Tisting the honiogunity of Vi : :f 17443t
X [optn) X E . Y16
1 ]G0 ppm 100.608 4336 4232 4205 4206 4222 4238 ™ -
2 ]1000.6% ppm 1008 000 397ED 39568 38066 39823
'TE veloe: 1.488E+G01 - .
F-Value: 5.350E+060
The ditferance between 142 and 522 s sigrificant
The Homogeneity of Variance datasheet 0 . : ) . .
0.000 50.000 190.000

. ) The Calibration Curve display
Residual Analysis

This graph displays the deviations of the calibration
points from the calculated linear regression curve. It is
used to determine whether there is an outlier in the data
orif there is a significant problem over the working range
of the calibration.

4. Options Memj

The Options menu items are used to set parameters for
different features of the program.
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General Parameters

The General Parameters dialog box appears, where
general information about the current file is displayed. A
title and comment can be entered, if desired.

Filenams : CAWINDOWS\DESKTEP\CONTRO 1 \NEW. VAL
Sample Run: CADIN\DATAVNEW3IA TOC

Bate: B1-16-1996

Time : %21

Upit : ppm

Analpsiz Type : TC/ST
Title : {nowz |
Comment: | !

The General Parameters dialog box

File Name

Displays the name of the file where the Validation
results are stored.

Sample Run

Displays the name of the file where the data for the
validation calculations are stored.

Date / Time
Displays the date and time of the validation.

Unit
Displays the analysis unit of measurement (ppb,
ppm, etc.).

Analysis Type

Displays the analysis method (TC, IC, etc.) of the
injections.

Title
Enter a title, if desired.
Comment
Enter comments, if desired.
Press OK to save the entries, or press Cancel to exit
the dialog box without saving.
Display Font
Opens the Font dialog box to customize the on-
screen fonts.
Display Options

Define the precision of the X- and Y- values, and
change the X- and Y-axis titles.

—MNumber Formatting
K-z Title:
Concentration

X Values Precision:

Y-Auis Title:
Area

Y Yalues Precision :

The Display Options dialog box

File Export Options

Enables the user to select items of information to be
exported to an ASCII file.
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¥ General Parameters
¥ Compiete Datasheet

I Variation of Homogenity

5. Help Menu

[ Lineasity Content
¥ Residuals
I Cafbration Fumction Opens the table of contents of the help file.
Separatar: T abulator g
About

Displays version number and registration information.

The File Export Options dialog box

In the Separator drop down list, select the character for
separating items in the ASCII file: space, tab, comma, or
semicolon. '

6. Calculations

The following is a list of calculations performed by the

Validation program.
Print Options Checking the Homogeneity of Variance
Designate the items to be printed. For both points under consideration, the variances are
calculated using the following equations:
I¥. General Parameters
- 16
% Complete Datasheet —\2
7 Variation of Homogehily Z (.y if - y i )
[# Linearity S? — I-':I
F2 Regression Datasheet ‘ ni — 1
[Z Residual:
[ Catibsatien Function Where:
Ptint Titte:
[mc Method Validation following DIN3S402-A51 10
Z Vi
}T‘_ —d=l._

The Print Options dialog box n

]

Next, for the F-test, the following test value is calculated:

Recalculation . El 5
Select this item to recalculate all results of the V= ? - IV = o
current Validation. Wi or

’ 2
5

v =
Validation strictly following DIN

When enabled, the validation calculation strictly
follows DIN 38402 requirements, i.e., only the first

2 12
10 with 51 = Sie

and compared with the value taken from the F-table for

1njection of every standard is used for calibration fi=f,=n-1=9 _
(except for the first and last standards, which are

averaged). Otherwise, the mean value of all area Results

counts is used for calculating the calibration. TV < F

2
If 5HA99%:  then the difference between variances 5

. 2
Save Settings on Exit and “10 is not significant.

When enabled, the display parameters are saved.
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1t IV 2 Frpoom,

2
and 10 is significant.

Linearity Test

For this test, use the first injection of all calibration
points. The following equations are used:

The linear calibration equation

y=a+bex
where: |
2
S5
a= ;—b;

Standard deviation:

where:

y=a+bx,

Process standard deviation:

Sy

SID_ b

Relative process standard deviation:
5,5 100%

X

Vo =

X

Coefficient of correlation:
2
2 - x)(% 5)

ST

, then the difference between variances S

The quadratic calibration equation
y=a+bex+cex’

where:

a ‘—‘(ny ——bei —ch,.z)/N

b Lo =L
Ou
c= Qnyxz - szyQH

(.) -0.0.
0, = x} —((ij)z /N)

Oy = 2 (x3)- ( ) (X1 4)
0, =% % ~((Xx)Xx2)/ )
0, =Xt -((Zx))rw

0p, = X (xi2)-(Zr )(Z52)/ V)

Standard deviation:

Z(y,- "}A’:‘)z

T N-3
Sensitivity:
E(;) =b+2cx

Process standard deviation:
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Relative process standard deviation
$,,100%

X

Vo =

Chapter Nine Control Charts

F-test
For the F-test, the following test value is calculated:

1.  Overview of Control Charts Software

DS* =(N-2)s2, - (N ~3)s2,

D§?
2
¥2

TV =

s

This value is compared with the value obtained from the
F-table for

fi=lang fi = N =3

Criterion:

2

1t 77 < Fro9%  then the difference between DS® and > is
not significant. The calibration may be regarded as linear
in the working range.

2
£ 7V 2F 9% then the difference between DS’ and 52
1s significant. The calibration is not linear in the working
range.

o
38
ontrol sample 50.19 z 05/30/97 15:02:48
B8 control sample 5017 : 3 0513097 15:08:58
4] contral semple 50.29 i 05/30/97 15:15.08
oritrol sample 5018 ] 05130197 15:24:20
P control sample 50,03 Q5130497 15.27:30
Zcortrol sample 5617 2 {05/30/97 15:33:44
2] controt sample 50.08 {05430/97 15:39:50
control semple 50.23 3 105130497 15:45:56
st control sample 150,33 05/30/57 15:49:00
S control sampie 50,55 05/30/57 13:50:50
nadelcontrol semple 50.80 i 05130/97 14:06:16
[EB ] contral sample 50.42 j o 05/30/97 14:33:02
(38882 controf sample 50.40 : 05/30/57 14:43:00

The Control Chart window

The Control Charts software monitors precision and
accuracy of a defined data set.

The software supports four Control Chart types:

¢ Mean Value Control Charts

¢ Recovery Control Charts

¢+ Blind Value Control Charts

Spanwidth Control Charts

<+

Each Control Chart type may be used to create Control
Charts for different working ranges and analysis methods.

Control Charts are valid for a specific period of time; after
that, a new Control Chart must be created.

The limits for a new chart are copied from the previous
Control Chart of the same working range and analysis
method.

For each Control Chart, a file is created which contains
general information about the type, data structure and
other global data. This file also contains all data required
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for sample identification as well as data required for
display and calculation of the entire Control Chart.

re- Note: Once samples are added to a Control Chart, they cannot .
be deleted. :

Either select Control Charts from the Tocentr program
folder or select Control Charts from the TOC Control

Validation menu. :

2. File Menu

The File menu

New
The New command opens a sub-menu from which one of
the file types described below is selected.

The New menu

Select any of these options to open the Open dialog box.
To create a new Control Chart, enter a new name in the
File Name text box, then select OK.

When OK is selected in the Mean Value, Blind Value, or
Spanwidth Control Chart Open dialog boxes, the
following Control Chart Options dialog box is displayed.

When OK is selected in the Recovery Control Chart Open
dialog box, the Recovery Control Charts Option dialog box
opens first. Fill in that dialog box as described on p. 172,
then click OK to open the Control Charts Options dialog
box shown below.

Filename: ]
CAWINDOWSADESKTOPACONTAQ~IATEST.CCM
Pieviouws Eontrol Chart:

initiol Dote: Drate of kst entty;
16-06-97 B6-06-97

Thast |D:

Hser;

The Control Charts Options dialog box

Filename

The file name and path displays in the non-
modifiable filename field.

Previous Control Chart

The name of the control chart previously used to
track this data displays in the non-modifiable
Previous Control Chart field.

Initial Date

The date the control chart was created displays in
the non-modifiable Initial Date field.

Date of Last Entry

The date which the control chart was last modified

displays in the non-modifiable Date of Last Entry
field.

Chart iD

Enter a brief description of the control chart in the
Chart ID text box.
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Enter the name of the user of this control chart in
the Usertext box.

Mean Value Control Chart
The Mean Value Control Chart (.ccm extension) checks
the accuracy of an analytical method on an instrument. In
some special cases this chart can be used to detect system
errors. For example, when using certified standard for the
control samples over a long period of time, control value

drifts indicate a change in system performance.

Recovery Control Chart
The Recovery Control Chart (.ccr extension) tests an
analytical method for matrix influences and provides a
restrictive control of accuracy by testing proportional
system errors. We recommend using certified standards
for Recovery Control Charts, which will test the accuracy

of the system as well as the recovery rate.

=
£3 tocentr
29 data

mypiey.com

i mvprev2.com
ii test.ccm

1 tect?.com
?,5 testd com
K| testd.com
ok testS.com

S

The Recovery Control Chart dialog box

%

Recovery Control Chart Options Dialog Box

The Recovery Control Charts dialog box, shown
below, opens when File/New/Recovery Control
Chart is selected to open the Open dialog box, then
OK 15 pressed.

Using the radio buttons, select either Certified
Standard or a Real Sample as control samples.

Certified Standard
When using certified standards, choose between |
standards with fixed or variable carbon contents.
For a fixed content standard, verify that the

172

TOC Control Software Manual

standard will be available for the entire time the
Control Chart is valid.

If using a fixed concentration, select Fixed
Theoretical Concentration and enter the
concentration of this standard in the text box below.

To use standards with variable amounts of carbon,
do not select Fixed Theoretical Concentration.
Enter the standard concentration in the Setup
Control Tracking Setup dialog box, accessed by
selecting Validation/Setup Control Tracking in the
TOC Control application.

Real Sample

When using real samples as control samples,
process them in two different ways.

a) For samples spiked with a fixed concentration of
carbon, select Fixed Concentration of the Spike
Component and enter the spiked content in the text
box.

b) For control samples with different spiked
amounts, enter the spiked content under Setup
Control Tracking on the Validation menu in the
TOC Control program.

Blind Value Control Chart

The Blind Value Control Chart (.ccb extension) is a
special form of the Mean Value Control Chart used for
quality assurance of the instrument and variable
elements.

This Control Chart can be used with analytical methods
where the blind value i1s different from zero and normally
distributed, 1.e., -BOD, COD-determination and special
photometric methods. Here, the control sample is the
blind sample for the respective analytic method.

Unlike the mean value Control Chart, the control value is
the information value (absorbance, peak height, peak
area) received from the analysis.

Spanwidth Control Chart

The Spanwidth Control Chart (.ccs extension) tests the
precision of an analytical method and monitors the
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accuracy under actual conditions (Drift Control). For this
type of Control Chart, there are several existing models
for calculating the control and warning limits,

We recommend calculating only the upper control limit;
defining the upper exclusion limit is optional. The lower
control limit is zero during measurement of multiple
determination with up to six samples.

General Parameters dialog box

This dialog box opens when OK is selected on the
Control Chart Options dialog box. Enter additional
mnformation and parameters for the new Control
Chart in this dialog box.

Max. Samples in Pre-periad - E
Max Samples in Contiol-period :
Control Chart type - Meanvalue
Working Range - L f
TOC Methed : TC
Unit - ppm
Exclusion Limit }2}:
Parameter :
M easuring Method - '
Matrix ;

The General Parameters dialog box

Max. Number of Samples in Pre-Period

In the Max Number of Samples in Pre-FPeriod text
box enter the number of samples to be used for the
preparation peried. This value is important because
the samples are used to calculate the limits {upper
and lower warning limit, upper and lower control
limit) after all samples of the preparation period
are added to the Control Chart. The default value
1s 12,
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rm Note:

Max. Number of Samples in Control-Period

Enter the estimated maximum number of samples
in the Control Chart; the default is 50.

Working Range

Enter the working range for the current Control
Chart. Match the range with the concentration of
the samples used for control tracking and the
concentration range of the calibration curve
selected. To check the linearity of the calibration,
see the Method Validation chapter.

TOC Method

Enter the TOC analysis method (T'C, IC, ete.) for
this Control Chart. During data addition, the
samples are checked when the analysis type
matches; otherwise the sample will not be added to
the Control Chart.

When an Out of Control Event or an error occurs during
data addition, 2 messa ge 15 displayed in the Message Log.

Unit
Define the unit of the control samples, ensuring

that only samples with the same unit are added to
the Control Chart.

Exclusion Limit (%)

This value defines the upper and lower exclusion
limit of the Control Chart. This limit is only
defined once and will not be changed with the
recalculation of the other limits.

No. of Injections (Spanwidth Control Chart only)

For the Spanwidth Control Chart it is
recommended that only control samples with the
same number of replicates be used as that value
defines this number. The control sample is added to
the Control Chart, even when the number of
replicates differs.

Parameter / Measuring Method / Matrix

These are information fields for your reference only.
Enter relevant information.
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Following CC

Open

Select this menu item to create the Following Control
Chart.

Previous Conbrol Chat :
[

New Controf Chart ;

The Following Control Chart dialog box

Previous Control Chart

When a Control Chart is already loaded, the file
name 1s added automatically to this dialog box. The
BROWSE button can be used to locate a different file.

New Control Chart
Enter the file name of the Following Control Chart
in the Edit field. The BROWSE button is used to
select a directory where the new Control Chart will
be saved.

Create
Press CREATE to read the data of the previous
Control Chart and calculate the new limits from
the samples of the control period stored in the
previous Control Chart. :

Show Parameters / Show Options / Show Limits

After creating the new Control Chart, the SHOW
PARAMETERS, SHOW OPTIONS, and SHOW LIMITS
buttons are enabled. Use them to view information
on the created Control Chart.

Press OK to save the new, empty Control Chart

under the assigned file name in preparation for use.

Select Open to access the Open dialog box. Use this dialog
box to open an existing Control Chart.

TOC Control Software Manual
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Save
Choose Save to save the current data. If the data has not
been saved previously, the Save As dialog box opens.
Save As
Choose Save As to open the Save As dialog box. Use this
dialog box to save the current data to a new file pame or
location.
Printer Setup
Select Printer Setup to open the Printer Setup dialog box.
Options will vary depending on the system printer.
Print
Select Print to print the current control chart.
Close
Exits the Control Charts program.
View Menu
These menu items are used to display the features and
parameters of the Control Charts.
@ NG
B
The View menu
Show Graph

Select Show Graph to open a dialog box where the table
data is displayed as a graph. This graph can be
customized; see p. 142 for more information.

The header contains information about the selected
control sample. The footer contains information about the
current Control Chart.

To change the current sample information, move the
mouse pointer to the solid vertical gray line. When the
mouse pointer changes to a double arrow, hold the left
mouse button down and move the line to the desired point
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on the graph. When the left mouse button is released, new
information is displayed in the header.

Smpl.No: 1 Semple ID: contral sample  Control Value: 5027 Date: 05/30/97 14:56:38
Meanvaive Controlchart
60.708 v

(7]
4]
=
[
>
s 50853p:
& S

(=
Q

40.587'
0 B 15
Sample Reference

Parametes;

Method:

Matrix;

The Graph display
Statistics

Select Statistics to display information relevant to the
loaded Control Chart. Select OK to close the dialog box.

Type : Meanvalue
No. of Samples for the prep. period: 12

Total No. of Samples: 14

Mean Centrol Value: 50.28

Upper Contro] Limit: 5092

Lower Control Limit: 4964

Upper Waming Limit: 50.70

Lower Waming Limit: 49 85

Upper Exclusion Limit: 57.82

Lower Exclusion Eimit: 42.73

Control Period
Mean Control Value: 50.41

Std. Dey.: 6.01
Coeff.var,; 0.03%

The Statistics dialog box

Type
Type displays the type of Control Chart currently

open (Mean Value, Recovery, Blind Value, or
Spanwidth).

No. of Samples for the Prep. Period

No. of Samples for the Prep. Period displays the
number of samples used for the preparation period.
This number was set when the chart was first
created. For Following Control Charts, this number
will always be zero.

Total No. of Samples

Total Number of Samples displays the total
number of sample entries. The total includes
samples used during the preparation and control
periods.

Mean Control Value

The Mean Control Value is the average control
value calculated from all samples of the
preparation period. This value is calculated from
the samples in the preparation period or, for a new
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chart, carried over from the control period of the
previous Control Chart.

: Contro! Chart:
| [CATOC\PRDGRAM\SOPPM CCH }

.. : The preparation period is the control period taken fn; .
Upper/Lower Control Limits and Upper/Lower § Eﬂgc\pggsm.;\mpm}%m -
Warning Limits

Lo . Meanvalue t-Test:
The ‘Upper and Lower Con-tzrql Limits and Warning Mervaliue Contol Pard ™ T
Limits are the calculated limits of the current ;‘;?::i"go';‘:gf;ﬂ‘@';Pe"mf: o007
i eriod: .
Control Chart. The values are calculated from the o Variance Preparation Period: 0.000
. . . Test valye: 0.68600
samples in the preparation period or, for a new  Testing the - T
h :t k ﬁ' th tr I er'od of the revi us Testing the homogenity of variance:
¢hart, taken from € coniro pert p 0 Meanvalue Control Period: 50.407
Control Chart_ b Meanvalue Preparation Period: 50,407
] Variance Conteol Period: 0.00D
g Variance Preparation Period: 0.060
Upper/Lower Exclusion Limit | Test value; 1.000

The displayed values are set during the creation of
the Control Chart. They must not be changed
during the lifetime of a Control Chart system.

The Comparison Between Control Charts dialog box

Select COMPARE to begin the statistical comparison. The
following two methods are used to check long-term
deviations in the Control Chart.

Mean Control Value / Standard Deviation / Coefficient
of Variation

The Mean Control Value, Standard Deviation, and
Coefficient of Variation are calculated from all
samples of the control period (except excluded
samples), and are updated with every new data
addition. The difference between this mean value
and the mean value stored in the Control Chart
shows long term changes of the control samples
during the lifetime of the Control Chart.

Mean Value T-Test

The mean values and variances are calculated from
the control and preparation period. Then a test
value is calculated and compared with the
corresponding value from the T-table. This
comparison shows whether the Jong term deviation
of the control samples is significant.

The equations are:

_fz’ NINZ
S, | N +N,

Comparison Between Control Charts

After finishing a complete Control Chart, the current
results of the control period must be compared with the
results from the preparation period. For Control Charts
without a preparation period, the current values must be
compared with the results of the preparation period taken
from the previous Control Chart.

TV:F‘

with:

(N, —1)s] +(N, - 1)s?
N +N, -2

for- M =N, =N fi=F;f=2N-2

8§, =
Enter the file names of the Control Charts or use the
BROWSE button to locate the files. When there 1s a Control

Chart open, the file names are automatically entered from

that chart. Criterion:

TV <= t(f, P = 95%): deviation is not significant
TV > t(f, P = 95%): deviation is significant
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Testing the Homogeneity of Variance
This test is performed exactly like testing the
homogeneity of variance during Method Validation.
See the section on Validation (p. 165) for the
equations.

List Out of Control Events
After adding new control samples to the control period of
a Control Chart, the control value is compared with the
defined limits. Several events can occur which show that
there are long-term changes in the analytical performance
of the instrument. When an Out-of-Control event occurs,
the instrument has to be checked for system errors. After
fixing the problem, re-calibrate the instrument and
perform Method Validation again.

During measurement, a message is recorded each time an
Out-Of-Control event occurs. In this message box, all Out-
Of-Control events are listed which occurred during the
lifetime of the current control period.

sph Dut of Control Event:

E] 7 conliat values are below the mean contiol value

The Out of Control Events dialog box

The following Qut-of-Control Events can occur during the
lifetime of a Control Chart:

¢ One control value exceeds the control or exclusion
limits

¢ Two out of three control values exceed the warning
Limits

¢ Seven consecutive control values are above or below
the mean control value

-

¢ Seven consecutive control values show an increasing or
decreasing tendency

TOGC Control Software Manual

» Note: When an Out of Control Event or an error occurs during
data addition, a message is displayed in the Message Log.

4. Options Menu

T}xe Options menu items are used to set parameters for
different features of the Control Chart software.

The Options menu
Display Font
Select Display Font to open the Font dialog box. Use this

dialog box to select a new screen font. See Printer Font, p.
62, for more information on the Font dialog box.

R R
e
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=1 e Allaniic infine
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The Display Font

General Parameters

The General Parameters dialog box displays the
parameters for the current Control Chart. Some items
cannot be changed after the Control Chart is created.
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Max. Samples in Pre-petiod :
Max Samples in Control-period :
Control Chart type : Meanvalue
Working Range : { ) 4]
TOC Method : TC
Unit - ppm
Exclusion Limit [Z]:
Parameter : J
Measuring Method : |
Matrix : _]

The General Parameters dialog box

Max. Number of Samples in the Preparation Period
The Max Number of Samples in the Preparation
Period displays the number of samples used for the
preparation period. These samples are used to
calculate the limits (upper and lower warning limit,
upper and lower control limit) after all samples of
the preparation period are added to the Control
Chart. This field is modifiable. The default 1s 12.

Max. Number of Samples in the Control Period

The Max Number of Samples in the Control Period
field displays the maximum number of samples in
the Control Chart. This field is modifiable. The
default is 50.

Control Chart Type

The Control Chart Type field displays the current
type of Control Chart.

Working Range
In the Working Range text box enter the working
range for the current Control Chart, e.g., 10 — 100
ppm. The range should correlate with the
concentration of the samples used for control
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tracki.ﬁg and also with the concentration range of
the used calibration curve. To check the linearity of
the calibration, see the section on Validation (p.
155).

TOC Method

The TOC Method displays the analysis type (TC, IC,
etc.) for this Control Chart. During data addition,

only samples of the specified analysis type are
added to the Control Chart.

m Note: When the Message Log displays “Checking Controls” and
the analysis type does not maich, an error message is
added to the Message Log.

Unit
Displays the unit of measurement. Ensure that

only samples of the same units are added to the
Control Chart,.

Exclusion Limit (%)

This value defines the upper and lower exclusion
limit of the Control Chart. This limit is only
defined once and cannot be changed with the
recalculation of the other hmits.

No of injections (Spanwidth Control Chart only)

For the Spanwidth Control Chart, it is
recommended that only control samples with the
same number of replicates be used, as that value
defines this number. However, the control sample
is added to the Control Chart even when the
number of replicates differs.

Parameter / Measuring Method / Matrix

Enter common parameters for sample conditions,
sample origin, and sample matrix.

Control Chart Options

Common parameters for the current Control Chart are
displayed in this dialog box. Fields that cannot be
changed after a Control Chart is created are dimmed.
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Filename:
. CATOCA\PROGRAMASOPPM.CCM

i Previous Contiol Chart:

Initial D ate: Date of last entry:
05736797 05230787

Chart |D:

[Mv 11796 |

User

Iﬂperatm |

The Conirol Charts Options dialog box

File name

The file name and location of the current Control
Chart is displayed.

Previous Control Chart

The file name of the previous Control Chart is
displayed.

Initial Date / Date of Last Entry

The Initial Date and Date of Last Entry display the
current system date when a new Control Chart is
being set up. When a saved Control Chart is open,
the relevant dates are shown.

ChartID
Enter an identification for the Control Chart.

User
Enter the name of the user.

Recovery CC Parameters

The items in this dialog box display the same parameters
as those when the new Control Chart was created. Fields
that cannot be changed after a Control Chart is created
are dimmed.
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Previous Control Chart

When a Control Chart is open, the file name is
displayed in this dialog box. The BROWSE button
can be used to locate a different Control Chart.

New Control Chart

Enter the file name of the Following Control Chart.
The BROWSE button can be used to locate the

directory where the new Control Chart will be
saved.

Create

Click CREATE to read the data of the previous
Control Chart and calculate the new limits from
the samples of the control period stored in the
previous Control Chart.

Show Parameters / Show Options / Show Limits

After the new Control Chart is created, these
buttons are enabled. They may be used to look at
the parameters of the created Control Chart.

Press OK to store the new, empty Control Chart
under the defined file name.

Print Options

Select Print Options to open the Print Options dialog box.
Select information to be included in a printout. An
organization, department, and address can be entered.
These items will be included on the printout.
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7 Gene:al Pasametes
{¥ Control Chart Limits

~Eonisol Chan Dato
¥ Chart

Drganisation:

Department:
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Address:
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The Print Options dialog box

General Parameters
Select General Parameters to print the information
displayed in the General Parameters dialog box.
This dialog box can be viewed by selecting
Options/General Parameters.

ASCI Export Options ‘
Select a separator from the drop-down list. During ASCII
export, items of information are separated by the selected
separator. When importing the ASCII file into another
program, the separator used must be specified.

ASCH - Exporl Parameter:::o:

Ca—

The ASCII Export Options dialog box

ReCalc Limits

After excluding samples from calculation, select this
menu item to recalculate the limits of the current Control

Chart.

LSRR g

Select OK fo recalculate the limits
of the current Conirol Chart

Enable Exclusion

When a check mark is displayed next to this menu item,
exclusion is enabled. When control samples are excluded,
they are not used for calculations or the determination of
Out-of-Control events.

re Note: Add a comment regarding the reasons for the exclusion in
the Control Chart.

Save Settings on Exit

When a check mark appears next to this menu item, all
program settings are saved when the program is closed.

Help Menu

Content

Select Content to open the table of contents for the Help
file.

About

Select About to view software registration and version
information.
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Chapter Ten Program Check

To ensure data integrity, this auxiliary program checks
whether any program files have been modified,.

Select the Program Check item from the Tocentr folder.
This opens the Check the Program Files window.

Check the TOC-Contrel program files were
changed or not.

Check is finished. << No changed >>
Detaii is the citociprogramicheck.t<t file. Push the [Notepad..]
button,

Ensure data integrity with the Program Check

Select EXECUTE to perform the check. When the check is
finished, the results will be displayed in the window. For
details on the check, select NOTEPAD.

L Vi

#x Check the Program Files »=

Program Hame : TOG-Control
Bersian : 1.88
Eheck Date : 1997-11-07 18:32:11

[Filenane File.Size Date.Time Check.Sunm
teccntui.exe [1]:4 154 DK
jtocval.exe [1]:4 114 1138
\ 0K 0K 114

DK 0K oK

0K 114 114

0K 0K 114

134 114 114

OK 114 134

View the defails of the Program Check in Notepad
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Chapter Eleven  Verification

The TOC Control software supplies verification data so
the operator can verify that the software is working
correctly and that data is being processed correctly.

The verification files are listed below:

File Name File Size (KB) Date Stamp Time Stamp
VAL TEST. PKT 29,498 11-07-97 16:57
VAL_TEST.MET 310 11-07-97 15:13
VAL _TEST.CAL 353 110797 1651
VAL_TEST.TOC 1,132 11-07-97 16:58

These files are available on Disk 3 of the program
mstallation disks. Create a directory for the files (e.g.
\tocentr\test), then copy the files to the directory.

Verification Procedure:
1. Start the TOC Control program.

2. From the File menu, choose Open, and open the
“val_test.toc” file.

3. Select Attach Data File from the File menu, and
choose the “val_test.pkt” file. This enables the program
to locate the Peak Profile data of the analyses.
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